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1

Introduction

This manual explains the operation procedure for Layout and Print Tool 2 (referred to as “Layout Tool
2”), which enhances the printing.

Layout Tool 2 enables:

® Easy printing operation corresponding to media size

® Multi-layer printing with color and white ink and varnish (*1)
® Single-layer printing via ValueJet Layer Editor

For the printer operation and ink handling, see the printer's operation manual.

The name, design and specifications of Layout Tool 2 are subject to change without notice.

Windows described in this document are registered trademarks of US Microsoft Corporation in US
and other countries.

*1 Varnish is only available with UV printers.
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ValueJet Layer Editor and Layout Tool 2

To perform following printing, please use Layout Tool 2.
The comparison table below briefly describes the specifications of ValueJet Layer Editor (stored in
the supplied CD-ROM) and Layout Tool 2.

For available image formats, see 3. Image Formats.
For layer printing, see 4. Printer Setting and Print Method.

For the details of ValueJet Layer Editor, see its operation manual.

UV Flatbed Printer

Layout and Print Tool 2

ValueJet Layer Editor

s

4F

Function

- Enables the layer printing for the
image data.

- Users can edit the layer print layout for
up to 15 layers and save it.

- Receives the print data from the printer

driver.

- Users can assign the received print data
to each layer.

- Requires Layout Tool 2 or other printing

application for printing.

Intended use

- Suitable for small print production or
inserting text for each printing.

- Recommend to use ValueJet Layer
Editor for large print production.

- Saves the already converted data for
printers to start printing soon after sending
data to a printer.

- Suitable for repeating print.

Image printing (PNG/TIFF) v N/A
Multi-layer printing
(Print on the same spot to v v
build up layer on layer.)
Single-layer printing v
(2 or 3-layer printing in one | (*Available when sending a print data to v
pass) Layer Editor.)

v

Layer Control

N/A

(Change the printing speed,
vacuum fan mode, and etc.)
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Roll Printer, Hybrid Printer

Layout and Print Tool 2

ValueJet Layer Editor

Function

- Capable of performing layer printing
using image data.

- Users can edit color and white data to
create a layer printing layout and save
it.

- Receives the print data from the printer
driver.

- Users can assign the received print data
to each layer.

- Requires Layout Tool 2 or other printing
application for printing.

Intended use

- Suitable for small print production.
- Recommend to use ValueJet Layer
Editor for large print production.

- Saves the already converted data for
printers to start printing soon after
sending data to a printer.

- Suitable for repeating print.

Image printing (PNG/TIFF) v N/A
Single-layer printing v*
(2 or 3-layer printing in one | (*Available when sending a print data to v
pass) Layer Editor.)

v

Layer Control

N/A

(Change the printing speed,
vacuum fan mode, and etc.)

Printing Large Image

When printing a large image from Layout Tool 2 or Windows driver through ValueJet
Layer Editor (referred to as "Layer Editor"), it takes a time to accumulate the data in Layer
Editor, and the printer may not be able to start printing quickly.

To perform printing more efficiently:
- Accumulate the data in Layer Editor in advance to reduce the idle time.
- Directly send the data to printer when the layer printing is not performed.

It is more efficient to use Layer Editor when the same print data is repeatedly used.

Layout Tool 2 does not support “LayerEditor” option for VJ-628, XPJ-1641SR,
XPJ-1682SR.
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2 Operating Environment

This manual describes Layout Tool 2 Ver.1.8.7.

Before use, make sure the following Windows driver is already installed.

2.1 Supported Printer Model

The supported versions and functions for Layout Tool 2 are as follows:
Layout Tool 2 is compatible with the driver system requirements.

Printer Model Printer Type Driver Version | valueJet Layer

Editor
VJ-626UF 1.02 or later 4.1.0 or later
VJ-426UF (*1) 1.01 or later 1.0.0 or later
UV Flatbed Printer
XPJ-461UF 0.02 or later 5.0.0 or later
XPJ-661UF 0.01 or later 5.0.1 or later
Roll Printer
vJ-628 (Roll media loading printer) 1.05 or later N/A
VJ-628MP Roll Printer 1.00 or later 4.4.0 or later

(Roll media loading printer)

Hybrid Printer
VJ-1627MH (Roll media/Rigid media 1.00 or later 4.8.0 or later
loading printer)

Roll Printer
XPJ-1641SR (Roll media loading printer) 1.00 or later N/A

Roll Printer
XPJ-1682SR (Roll media loading printer) 1.00 or later N/A

Available menus and functions vary by printer model.

This manual describes the supported printer type (UV Flatbed or Roll) or printer model for the
menus or items designed for specific model or printer type.

For Hybrid printer, refer to the function of Roller printer.

Some menus are disabled if you select 4-color configuration on your printer driver, or if the ink
colors are not available on your printer.

*1 Layout Tool 2 does not support the varnish glossy finish option for VJ-426UF.
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2.2 Printable Media Size

Preset Media Size and Custom Media Size:

Custom Media Size (mm)
Printer Model Preset Media Size
Width Height
VJ-426UF Fullsize A3
Same as Preset Media Size
VJ-626UF Fullsize A2, Fullsize A3
VJ-626UF i 360 405
Rotary Unit (No margin)
XPJ-461UE Fullsize A3
(No margin)
Same as Preset Media Size
XPJ-661UF Fullsize A2, Fullsize A3
XPJ-661UF i 360 405
Rotary Unit (No margin)
VJ1-628 Fullsize Al 620 3200 *1
(No margin)
VJ-628MP Fullsize Al 620 3200 *1
(No margin)
VJ-1627MH Fullsize AO Plus 1615 3200 *1
XPJ-1641SR . .
XPJ-1682SR Fullsize AO Plus 1615 3200 *1
Media Type and Size:
Type Size Width Height
FullSize A1 Al 594 841
FullSize A2 A2 483 594
FullSize A3 A3 Plus 483 329
FullSize AOPlus AO Plus 1240 841
Custom Size i 30 - Maximum media | 30 - Maximum media height of
width of the printer the printer

*1 3200 mm is not the maximum printable length (height) for these three models.
To print more than 3200 mm length per print job, please use the supported RIP

software.




Layout and Print Tool 2 Operation Manual

2.3 Supported OS

The supported Windows versions are as follows.
Install the latest service pack.

Windows7 Service Pack 1 or later [32bit/64bit]
Windows8/8.1 [32bit/64bit]
Windows10 [32bit/64bit]

The supported languages are as follows:

Japanese

English

Following restrictions apply depending on the OS version of your computer.
N/A=not available, restriction=restriction, v"=available without restriction

Details
7 8.1 10
;?]?;Script N/A v v For details, see 7.12 Insert Text.
Eii:F Image N/A restriction v For details, see 3.2 PDF File.
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3 Image Formats

3.1 Popular Image Format
The available image format is as follows:
See the note below for more detalils.

PNG (-png) *1,*2
Bitmap (.bmp)
JPEG (jpg) *3
TIFF (tif)  *2,*3

These files appear in the Folder Tree and the Image Preview on the right side of the screen.

® Use 24-bit RGB color model for the color data.
® *1 PNG format is the recommended format for Layout Tool 2.

[ *2  RGBA color model (with an alpha channel) can be used with RGB color
model.

® *3 CMYK color model data is not supported by Layout Tool 2.

When selecting the file, if the mark shown to the right
appears on the preview pane, this data format is not
supported by Layout Tool 2.

If you print the unsupported file, the printing may not be

available depending on formats or the printed color may differ
from the actual color.

[ it - Layut an i Tockz
"

B
io(E] Dptan Froer Settog e

The following dialog may appear for obviously unavailable files.
LayoutAndPrintTool

. Your specified file cannot be loaded.
_-Ll This file format is not supported.

WhenL this dialog appears, convert the file to PNG format.

10
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3.2 PDF File

If you are using Windows 8.1 or Windows 10, you can also use the following image format by drag
and drop.

PDF (.pdf)

PDF files do not appear in the Folder Tree and the Image Preview on the right side of the screen.
Select a PDF file from Windows Explorer.

If a PDF file contains more than one page, the following dialog will appears.
Select the page which you want to use and click Apply.

The file contains multiple pages.
Specify the page number,

() Current Page
(") Pages % pdf

1/2 pages

Apply || Cancel

® InWindows 8.1, a PDF file containing text cannot be used.
If the file contains text, the following dialog will appear.

!Q The PDF file can not be used.

® If atextis contained in the first page of the PDF file, the above dialog will appear. If it is
contained in other than the first page, the appropriate page will be skipped and the rest
of the pages will be loaded.

When loading a PDF file containing multiple pages, please note the followings:
» Once started, you cannot interrupt loading the PDF file.
» An Out of Memory error may occur while loading the PDF file.
» Do NOT load a document PDF file such as user guide.

® When converting PDF to image file, the image file resolution may be decreased.
Use the original image file, if you have saved it.

® An embedded profile such as color profile cannot be correctly applied.
|

11
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4 Printer Setting and Print Method

Layout Tool 2 offers the following print mode to enable the layer printing: Color Printing, White
Printing, Color-on-White Printing and Varnish Printing.
Choose the print mode depending on your desired output.

Each mode has different function:

Color Printing Prints color data on object.

White Printing Prints white data:
- on dark-colored object to achieve monotone printing.
- as white underbase.
- between color printings (double-sided printing)
as both underbase.

Varnish Printing Prints varnish data over the color or white printing to offer the
glossy finish and smooth texture.
You can also achieve the emboss effect.
(UV Flatbed)

This section explains the printer panel setting and printing method.

Important Notes for UV Printing (UV Flatbed)

Handling UV ink requires special care. Before use, please read 'Notification sheet (How
to handle UV inkjet printer/its supplies)' supplied with the printer and operation manual
of your printer.

Do not touch uncured UV ink.

If the printed area is not properly cured, go to 'Mnt.3 UV Scan' > 'UV Scanl Start'
from the operation panel to perform extra UV scanning.

-Depending on media type, media curl may occurred with layer printing.

-In multi-layer printing, if media curl occurs or the printed layer gets thicker, the height
of table is automatically (or manually) adjusted to keep proper gap between the print
head and the highest position on the media

If a wider head gap is required, distance between the UV lamp and media also gets
wider, resulting in insufficient UV power to cure the print.

-When creating emboss effect with multi-layer printing, distance between the UV lamp
and media may get wider as you build up multiple layers on the media.

With the wider head gap, if you print on non-embossed area of the media, the area may
not be properly cured due to insufficient UV power. In such case, please change order
to print layers.

UV Flatbed
® Layout Tool 2 enables to print multiple layers on the same spot. However, Mutoh cannot
guarantee the quality of excessive layered object.

12
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4.1 Print on Uneven Media

If distance between print head and media surface varies by using uneven media, ink mist will be
produced and it may affect print quality.
Try the steps below in such case.

® \We do not guarantee that you can achieve the print quality equivalent to those obtained
with appropriate media even if you follow the steps below.

A) Specify Low Speed from the printer panel. (UV Flatbed)

Panel Menu
Menul: Setup>
Set: ' User Type>
Menu User: : Typel - 10
**>6: ' Low Speed
Low Speed: 25% or 50%

® Since the print head traveling speed (printing speed) will be decreased to prevent ink mist,
the printing requires longer time.

B) SetHead Gap to Large from Layout Tool 2.

Prevent ink mist by printing with large dot.

® Print quality may be lower than setting Head Gap to Normal.

13
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4.2 Multi-Layer Printing (UV Flatbed)

Multi-layer printing is a layer printing method that a printer prints more than one layer data on the
same media by layer. Every time before printing the next layer, the print head goes back to the print
start position.
Layout Tool 2 offers two types of multi-layer printing methods. You can select it from the Printer
Setting menu as described below.

Method 1
Uncheck ‘Use MultiLayer setting of the printer’
(Default setting)
@
File{F) Option | Printer Setting | Ruler

Select Printer
Output Mode Settings
Use MultiLayer setting of the printer

Method 2
Check ‘Use MultiLayer setting of the printer’

File(F) Option | Printer Setting | Ruler
Select Printer
Output Mode Settings

Use MultiLayer setting of the printer

Layout Tool 2 sends more than one layer data to
the printer as one print job to print on the same
media layer by layer.

In normal cases, use this setting.

By setting the Multi Layer option to ON from the
printer panel with this setting, you can send layer
data to the printer one by one to print on the
same media layer by layer.

Once the printing is complete, the table
automatically moves to the eject position.

If more than one person shares the same printer,
this method is more preferable to avoid

accidentally printing on the wrong media.

With this setting, you can print on the same
media unless pressing the Remove Media key
on the printer panel.

To avoid printing on the wrong media, when the
layer printing is complete, press the Remove
Media key to remove the media from the printer.

In Method 2, to enable Multi Layer setting on the printer, set the Multi Layer menu to ON

from the printer panel.
Check the panel setting below.

Panel Menu

Menul: Setup>

!
Set2: Advanced>

Menu !
Adv. 7: Multi Layer

!
Multi Layer: On

14
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4.3 High-Density White/Varnish Option

If you want to print white or varnish (UV Flatbed) with high density, check High-Density option.
It allows you to print the selected white or varnish layer with double density (print speed will be
decreased by half).

White Printing
Ink Adjustment % [ High-Density
() Fast
[JChoke edges [ |Spread edges  0.10
(®) Fine J ? . Do
[]Enable gradation
() Super Fine
[lIgnore white in the non-alpha channel image
Printing method Under coating () All area (®) Image only

Varnish Printing
Ink Adjustment %  [~]High-Density

() Fast

[ Choke edges DSpread edges 0.10 mm
(®) Fine

[]Enable gradation
() Super Fine

[1Ignore white in the non-alpha channel image [ Glossy Finish
Printing method Over coating OAllarea @ Image only

For High-Density option in varnish printing, see descriptions of the Glossy Finish option on page 64.

15
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4.4 White Printing and Varnish Printing

When printing with white or varnish ink, the print finish varies by media being used.
Before using new media, make sure to run a test print to check for compatibility.

The default values set in Layout Tool 2 are optimized for characteristics of each printer model.
Run a test print and find the optimum settings for your media.

® Here are some points to check during test print.

<UV ink>
Run the ink adhesion tape test on a new media and make sure that the print does not come off.

<MP ink>

Perform three types of printings; layer printing, color printing and white printing to ensure that
the ink dries properly.

- When performing white-on-color printing on transparent media, if the image looks worse, the
white ink volume is too much. Reduce the white ink density.

- If ink bleeding occurs on your print, the ink drying time is not enough. Specify the ink drying
time between passes from one of the following menus:

- Operation panel or Printer driver: Pass Wait

- Layer Editor: Interval time (Multi Strike Setting)

16
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5 Main Screen

Below is the main screen of Layout Tool 2.
For the operation procedure, see the following pages.

{§ Untitled - Layout and Print Tool2 = |5 .
1 File(E) Option Printer Setting Ruler
H 10 15 20 25 0 35 40 45 (
1 I T O O O '-D“E::'m flomg)
o 13 Documents
i 3 Music
] gy
— Sample Pictt”
1 4 Videos
i - B English
i 4 {8 Computer
T o€ Network
0| % B8 Control Panel
i & Recycle Bin
& print Pr 5]
& Prin ]
20 |
] +[a]
T s %] 0]e]
| w O B e
ES Width 00 —
1 Q Height 0.0 < mm @ ﬁ g
ki o = - al=lg
Ready - x = 505.6,y = 76.6 75% NUM
Preview Switching Edit Area Image
Area/
Print Management Management
Area Area
Preview Switching Area/ - Displays the printer driver properties
Print Management Area - Switches the preview
- Starts printing
- Select the media size.
Edit Area - Displays the inserted image.
- Use as preview.
Image Management Area - Insert the image

- Change the image size and position.

17
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5.1 Change Origin Setting
From Option > Origin Setting, you can change the origin in the Edit Area by 180-degree rotation
check box.

0 Untitled - Layout and Print Tool2
File(F) = Option Printer Setting  Ruler
Language Setting

Reset Window Layout
Media Profile Management
Change Background Coler
Origin Setting

Printable Area Setting

In default, the origin in the Edit Area is set to top left.
When 180-degree rotation is enabled, the origin is set to bottom right.

With this setting, your design will be printed from the origin specified in this menu.
Please see the figures below and choose the appropriate setting.

Origin Setting X Qrigin Setting

Set the edit area origin position Set the edit area origin position

Cancel

Default setting

Once changed, this setting is saved in Layout Tool 2 and will be applied until you change it.

18
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Depending on the origin setting, the origin of rulers in the Edit Area and print start position on your
design change as shown below by arrow.

<When using the bottom-right origin (180-degree rotation is enabled)>
10 5 0

A

When using the top-left origin (180-degree rotation is disablgd)>

- Print start position
- Origin in the Edit Area, ruler zero point

For details of printable area, see 7.2 Printable Area.
For media loading position and print start position on the media, see the operation manual of your
printer.

19
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6 Basic Operation
6.1 Initial Setting (for Initial Startup only)

Before running the Layout Tool 2 for the first time, make sure to install the printer driver.
The following dialog appears to select the printer driver when you first run this application.
*This printer driver will be automatically selected from the next time.

Select Printer @
Printer Mame Drriver Name Port
MUTCH vI-626UF MUTOH w1-628UF 192.165.104.222
MUTCH vwI-426UF MUTOH w1-428UF 192.165.104.125
[ apphy | [ Close ]

If the driver settings have not been completed, the following dialog will appear. Click OK.

Initial Setting

Set the link to the printer driver

The printer properties dialog will appear.

Click 0K to complete the setting.

Then, the printer properties will open. Click OK.
This dialog will not close until you click OK.

=0 MUTOH VJ-626UF Printing Preferences =
Basic | Option | Color Adjustment | Utiity
Preset: | Curent Settng - save Delete
Output : [Printer - Edit Laye:
Page Setup
Page Size 150 A4 (210.0x297.0mm) b
widh: 210.0 £ mm
a Length: 297.0 {5 mm
Orientation © Portrait [CIRotate 180>
© Landscape [ Miror
210.0 x 287.0 mm
Print Quality
Media Type Generic. Media -
@ Fast
Fine
i
s
! Color Mode Color -
297.0
210.0
Version 0.03 Restore Defaults
ok | [ coneel || [ he |

20
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6.2 Media Size Setting

1. Click A to select the media size.

== -
+[a]
o a Ee S| ]
- T A e
B | wme . B0
ol | = s A\E
2. Select the size from the drop-down list of A.
Select from: Fullsize(A3), FullSize(A2) or Custom Size.
e | 4 9'/‘
" B & |
9| .~ H|a| O
9| Al #| o

When selecting Custom Size, the Custom Media Settings dialog appears.
Directly enter the width and height or click the up/down button to specify the value.

Custom Media Settings @
Media Size Image Size
wigth B 2 g, hidth 4730 mm
Height 5940 : mm Height 5840 mm

21
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6.3 Insert Image
Insert the image to each layer.
Upon startup of Layout Tool 2, the edit area for Layer 1 will always appear on the main screen.

1. Select an image file from B.
Click C to insert the image.

@ Untitled - Layout and Print Tool2
File(E) Option Printer Setting Ruler

MUTOH

J

MUTOH VJ-626UF

+[a]

Position
left 1140

Top 1640
Size
Width 2540

Height 2540 |2

Scale 100

lolic)

(s

® You can also insert the selected image by pressing [ctrl] + [i] keys instead.

2. The inserted image can be moved with the mouse or by clicking D (Edit buttons).
In E filed, you can directly enter the value of image position or size.

© Untitled - Layout and Print Tool2 (o)

File(£) Option Printer Setting Ruler

22
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3. If you use only one image, click F to optimize the image to the largest size such that fits entirely
within the printable area and center the image.

Positi

Lt 00 1

Top 0.0 mm

Size E E
/N

&

L ILANEIL

Width 0.0 =

Height 0.0

OOE

Scale i o A

For the details, see 6. Functions.

® The latest inserted image is the target for editing.
® If you click anywhere except for the inserted image, E and D become invalid.
If so, click the target image again.

4. Multiple images can be inserted.

© Untiled - Loyt nd Pt o2 o)

File(E) Option Printer Setting Ruler

——

i

+[a)
W | 2] 4]
o e BB e
| | wwu cnHalO
gl | = & almlgl

x=5404y=2152  S0% NOM

® The maximum number or size of image insertion depends on your PC capability.
® If you insert too many images or large images, the Layout Tool 2 operation including
printing may become slow.

23
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6.4 Layer Printing
6.4.1 Multi-Layer Printing

Print the selected layers with multi-layer printing according to the specified color mode or the multi
strike setting.

Specify each layer setting from the Choose Layer dialog.

A) Multi-Layer Setting
Click G to open the Choose Layer dialog.

ool &

[> 2w |2
EARGE

Right-click the layer to specify the color mode.
Up to 15 different layers can be assigned.

Check either Color, White or Varnish

(UV Flatbed) for the layer.
Choose Layer Dialog
Right-click to open the
context menu.
i — T -
. - g — Not available
v gzlt::vallable Color
— White v | White
! Varnish 12 5 Varnish
s 17 - s T m If you do not want to print the layer, check
Not available.
1 1 12 1 13 15 14 - 15 m
Total Pages 1 — .
v Not available
Color
| oK | Cancel ) ‘ ‘, White
- 2 Varnish

24
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Not available Setting
® Even if a layer is set to ‘Not available’ in this dialog, you can still select the layer and
print it from the ‘Print the selected layer’ dialog.
® This function can be used to delete unwanted layer. See page 20 for more details.

‘Choose Layer’ dialog for roll printer

® Multi-layer printing is not available for roll printer.
If you select the roll printer driver, each 1 layer of color and white are valid.
To perform layer printing, go to Printer Setting > Output Mode Settings to select Layer
Editor, and print from Layer Editor.

Select the layers you want to print and double-click the layers or click OK.
The selected layer is shown with the blue frame.

Choose Layer Dialog u

—

. o, _1% St

[s]]
=
-
I,
-
@
-

1 1= 1= 13 1= 1 s s 1=

Total Pages 2

OK | l Cancel

25
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You can adjust the image position from the main screen.

Left
Top
Size
Width &
B | reomor
scal
[ |
=l 9‘
Ready x=4378y = 4106 75% NOM

To show the preview of each layer after placing the image, click G again.

© Untitled - Layout and Print Tool2 ! (o)

File(E) Option Printer Setting Ruler

B Desktop Name
MUTOH - 2 Ubraries
5 B English
48 Computer

5 € Network
4 @5 Control Panel
& Recycle Bin

MUTOH VJ-626UF

Sample

& Send to Layer Editor

@ Version
® Exit

+[a

Position
et 00 : E,:n‘ 1+

mm

S T
8l | e iz W alo]
o | = & almlo

Ready x=4378y=4106  75% NUM

&
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Check the preview of each layer in the dialog.

Choose Layer Dialog
[ e
1 Q1B 1 s &g 1B s
6 1 7 1 8 1 9 10
1 12 1= 13 1 14 15
Total Pages
[ oK Cancel

® When swapping the position of Layer 1 and other layer, the confirmation dialog

You can drag and drop each layer.

lllllll'

()

=
[N

will appear if different print mode settings are applied to those two layers.
For more details, see Swap Layers in B) Print Mode Setting.
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The last layer with no image and Not available setting is deleted from printing.
To delete the unwanted layer, follow the steps below.

Example) The steps below describes how to delete Layer 2.

An image is added to Layer 1 to Layer 3 respectively.

DELETE ..

=P

'\
Double click on Layer 2. Select the image and click ™ to clear the image from

Layer 2.
In the Choose Layer Dialog, drag Layer 2 and drop it on Layer 3 to swap the
position of Layer 2 and Layer 3.

A
=P

1 &7 e 2 e 3 | =

Right click on Layer 3 (originally Layer 2) and check Not available. Layer 3 will be
shown with gray frame.

Mot available

Varnish
L T 3 TT— 1=

Close the dialog. The layers with right side gray frame and no image will be

deleted from printing. /—\
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B) Print Mode Setting

You can individually specify desired print mode setting per layer.
When newly creating .ladm file, ‘Apply Layer 1 print mode setting’ is enabled so that a print mode
setting which will be specified for Layer 1 will be applied to other layer.

Before printing, specify the print mode setting for Layer 1.

If you want to apply different setting per layer, uncheck Apply Layer 1 print mode setting and
individually specify desired setting per layer.
Print Mode
Clpply Lz,

Initial Setting

Layer 2 Setting
~ Save
(@) Select print mode file Initial Setting
Open/Delete
QO Specify print mode setting

When you unchecked ‘Apply Layer 1 print mode setting’, use one of following options to specify the
print mode setting.

Select print | To reuse a saved print mode setting file, check Select print mode file.
mode file
In the Print Mode dialog, click Open/Delete button. In the Open/Delete Print Mode
Setting dialog, select a print mode setting file and click Apply to load the file.

In the initial status, only ‘Default’ is available.

Open/Delete Print Mode Setting [ x|

Print mode setting file

Default v

Remove Cancel

If you want to newly save a print mode setting,
1) go to the Print Mode dialog

2) check Specify print mode setting

3) specify the setting

4) click Save to save the setting.

Print Mode
[liApply Layer 1 print mode setting!
Initial Setting
Layer 2 Setting
() Select print mode file Initial Setting

Open/Delete
(®) Specify print mode setting

Specify print | If you want to specify desired setting, check Specify print mode setting.

mode For more details of each setting, see 7.16.
setti ng Print Mode
D:Apply Layer 1 print mode setting
Initial Setting
Layer 2 Setting

() Select print mode file Initial Setting

(®) Specify print mode setting

Colar Printing
Color Balance
@i Red: - N 0
®) Fine
Green: - + ]

() Super Fine
Blue: - + 0

[[]Ne Coler Carrection
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Swap Layers

When Apply Layer 1 print mode setting is enabled, the print mode setting which specifies for Layer

1is applied to other layer.

If you attempt to swap the position of Layer 1 and other layer, the following dialog will appear to

select a print mode setting.

The print mode setting currently specified in Layer 1is applied to

other layers.
Select print mode option,

(®)Use original print mode setting:

() Apply new print mede setting

Retain existing print mode setting

Cancel

Example) The following example shows that how print mode setting will be changed when
swapping the position of Layer 1 and Layer 3 while following print mode settings are applied to

Layer 1to Layer 3.

Current settings

Apply Layer1 print mode setting
Print mode dialog value
Layer 1 Setting

Select print mode file
@ Specify print mode setting

Color Printing
Color Balance

[+] Apply Layer 1 print mode setting
Initial Setting
Layer 2 Setting

®) Select print mode file Initial Sett

Specify print mode setting

Color Printing
Color Balance

Layer 1 Layer 2 Layer 3
‘Specify print mode setting’ is selected. | ‘Apply Layer 1 print mode setting’ is ‘Specify print mode setting’ is
Print mode is set to ‘Fine’. selected. selected.

Print mode is set to ‘Fast’.
[] Apply Layer 1 print mode setting
Initial Setting
Layer 3 Setting

() Select print mode file Initial Sett

(®) Specify print mode setting

Color Printing
Color Balance

i (O]
Fast Red: = e o e
® Fine O Fine
: . Green: ; Green:
. reen: o [_) Super Fine
Super Fine Blue: Blue:
=T |

New settings after swapping the position of Layer 1 and Layer 3

When enabling following options

Print mode settings applied to each layer

New Layer 1

Layer 2

New Layer 3
(originally Layer 1)

@ Use original print mode setting

(originally Layer 3)

Of

@ Apply new print mode setting:

Retain existing print mode setting

@ Apply new print mode setting

[ViRetain existing print mode setting

#|iApply Layer 1 print mode setting
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Reload Print Mode File

When you checked ‘Select print mode file’ to use the saved print mode file, you can also choose
from following options:

Options Details Print mode display
Apply the print The print mode file available at the time when
mode file available | created .ladm file is applied.
at the time (Initial Setting)
Apply the latest Whenever .ladm file is loaded, the latest print Reload when loading
available print mode setting will be reloaded. ladrm
mode file

To apply the latest available print mode file, check ‘Reload when loading .ladm’ from the File menu.

& untitled - Layout and Print Tool2

[File(F) | Option Printer Setting Ruler

MNew (M) Ctrl+N =
Open(0)... Ctrl+0 [
Save(s) Ctrl+5S
Sawve as(A)...

Mon-Editable Mode(E)
¥ Reload Print Mode File

® Terms of Initial Setting and Default
Initial Setting | The factory default setting.
If you have changed some of the print mode settings and want

to restore the factory default setting, click the Restore Defaults
button.

Default The print mode setting file stored in the folder.

In the initial status, the setting in the ‘Default’ file is the same as
‘Initial Setting’.

You can rewrite the original setting of Default file. In that case,
use a recognizable name to save the file.
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C) Print

Before printing, check the layer setting from the dialog.

Choose Layer Dialog

L’a‘l‘

1

15

Total Pages 7

e

You can specify the multi strike
setting on each layer by entering the
number or clicking the up/down
button.

(UV Flatbed)

Check the total print pages (including
the multi strike setting) in the lower
right conner.

s U=

Total Pages 7

OK ] l Cancel
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Click H (Send to Layer Editor) to open the Choose Print Mode dialog.

{© Untitled - Layout and Print Tool2 el ) S
File(F) Option Printer Setting Ruler

B Desktop Name
55 Libraries
B English
4% Computer
5 G Network
4 9 Control Panel
4 Recycle Bin
| & Send to Layer Edi
z
==
+[a]
Position a
Left 00 > mm ¢"'{|" b
Top 00 A S
- Al X w
Width 00 al
8| e immlajo
=] g | = 5 almol

Ready x=4378y=4106  75% NUM

Click I (Print all valid pages).

Choose Print Mode X

Choose the print mode you want to use

—) Print all valid layers

I 1 Print with the specified color mode.

—> Print the selected layer
Normal Printing/Layer Printing/Sub Area Box Printing

Print Angle Adjustment Cancel

® For roll printer, the following dialog appears since it is not able to perform multi-layer
printing.

Choose Print Mode X

Choose the print mode you want to use

:—> Color Printing

Print with the specified color mode.

—> Print the selected layer

Normal Printing/Layer Printing/Sub Area Box Printing

Number of copies: D =

Print Angle Adjustment Cancel

To perform single-layer printing, check Layer Editor in the Output Mode Settings
dialog.

33



Layout and Print Tool 2 Operation Manual

6.4.2 Automatic Coating Printing

With the automatic coating function, the white underbase and varnish over-coating (UV Flatbed) are
automatically added to the selected single color image.

Automatically Coating Layers

< \arniish ( Over )

(UV Flatbed)

Color

H h White ( Under )

"

A) Print Settings

cify the automatic coating settings, click J (Print Mode Setting).
= (o]

J MUTOH VJ-626UF

+[a]
e wm,, =] 4 @
T
B | o WA o
= ISR STE

x=408y=4248 7% NOM.
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The Print Mode dialog appears.

White Printing

Print Mode
Apply Layer 1 print mode setting
Save
Open/Delets
Color Bal
[o] Saturat
9 Contrast:
[o] Bright
[INo Color Correction Gamma: 01
White Printing
Ink Adjustment %  [lHigh-Density Color Balance
OFast
[Jchokeedges  []Spreadedges  0.10 :
@® Fine 9 B g mm Contrast
[JEnzble gradation
O Super Fine Brightness: -
I hite in the non-alpha channel
Wi e driimss I o
Printing method Under coating OAllzrea  @Image only
Varnish Printing
Ink Adjustment 100 % High-Density Color Balance
Fast
Choke edges Spread edges 010 m e
Fine
Super Fi Bright -
lossy Findh
Gamma: 04
Printing methad Image onk
Head Gap Normal Large Restore Defaults

rofile

LUH1

Apply.

x o Ink Adjustment o High-Density
Fast
@ Fine [JChoke edges  []Spread edges  0.10 o
2 [ 1Enable gradation
O Super..

[JIgnere white in the non-alpha channel image

Printing method 1 Under coating ) Al area (®) Image only

Varnish Printing

EI Ink Adjustment % High-Density
[ (O Fast
EI DChoke edges DSpread edges 0.10 .

@) Fine
2 []Enable gradation 3

O Super Frue

[Jignere white in the non-alpha channel image [1 Glossy Fini
9 Printing methor Over coating OAllarea @ Image only
10

g

1. Undercoating, Over Coating, All area/lmage only
All area: Print the white underbase and varnish over-coating in the same area as specified in 6.2 Media

Size Setting.

Image only: Print the white underbase and varnish over-coating only under/over the image.

2. Enable gradation
*Check Enable gradation

Remain a gradient of image for white underbase or

varnish over-coating.

Convert a color image to black and white (2-tone)

image and print it with white ink or varnish.

3. Ignore white in the non-alpha channel image

-Uncheck Enable gradation

Print a solid white underbase or varnish
over-coating without a gradient of image.

Apply a solid printing on all color objects except
for transparent object.

» If checked, recognize white objects as transparent objects in a non-alpha channel image.

Original image Unchecked

Checked

a_p
deap
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Alpha Channel Image

An alpha channel image is an image containing transparency information channel as follows.

Popular image data
(= non-alpha channel image)

BMP, JPEG, TIFF, PNG (no transparency contained)

Image data with
transparency
(= alpha channel image)

/ 6 © ‘
Transparency or opacity of a color should be defined in the alpha
channel of the image data.

White Data Printed Result

Popular image data

Image data with transparency

Color-on-White Printed Result

Popular image data

Image data with transparency
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Before checking/unchecking Enable gradation, you can check whether the background of the image
is transparent or not from the printable area.

wout and Print Tool2
| ATzay TULSORE N-5—

@ ——— | Non-transparent
background

Sampl

e7 - | Transparent background

Sampl

}83.0x329.0mm

The gradation setting is applied on the images inserted in the printable area as below:

Original Image

(Non-transparent background) Check Enable gradation Uncheck Enable gradation

Jalipic Samp|e

You can check the selected layers from the Choose Layer dialog.
The dialog shows the image preview and color mode.
For the layer setting, see 6.4.1 Multi-Layer Printing A) Multi-Layer Setting.

Choose Layer Dialog o ]

oK Cancel

B) Print
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Click H (Send to Layer Editor). The Choose Print Mode dialog appears.

Click | (Print the selected pages).

Choose Print Mode

Choose the print mode you want to use

—) Print all valid layers

Print with the specified color mode.

—> Print the selected layer
\_/ Mormal Printing,/Layer Printing/Sub Area Box Printing

Jig Position Adjustment Cancel

The Choose Print Mode dialog appears.

Check the layer you want to print and click Print.
Choose Print Mode ﬂ

Choose color mode,

Print one page with the specified color mode setting

White

[#] Varnish

Sub area box printing

[[]5ub area box

Black

= o)
=
e
—_———
[
+[a]
e e
w © R E e
B | v B alOf
gl | = # almo
X =498y =4248 75% NUM
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C) Sub Area Box Printing

You can print each sub area created in the printable area (specified by arrow).

Printable Area Setting [ x |

Change printable area setting.
Specify margin, printable area size and number of printable area.

Media being loaded Preview
Width 4720 /
mm
Height 3190 mm

/

Layout Infermation

Distance from print start position

Left 100 S 100

Margin between printable area

Left 10.0 S ToP 100

Sub area box size

Width 100.0 = o
[] Duplicate image =
i 100.0
Height H m ’
e ch R bralEeis
Rows 2 = Columns 2 |
Apply Cancel

In the Choose Print Mode dialog, check Sub area box.
Choose Print Mode ﬂ

Choose color mode,

Print one page with the specified color mode setting

[ cCalor
[ White

[1varnish

Sub area box printi

e,

- Black w

Choose black, yellow or white for sub area box printing.
If the color mode for automatic coating printing is also specified in this dialog, the sub area box will
be printed with image data printing.

Sub area box printing

[] Sub area box Bl ek W

1 Yellow !
[ ] White -
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Functions
7.1 Main Screen

The following screen will appear when Layout Tool 2 starts.

1‘“2“‘3 ) 4/ —
File(F) Option Printer Setting Ruler
7\UHHSH||1D|\|||BHH\ZU \\\b\\l\mll\Ijs\l\\m\\\\%\\\\rt -?_:‘t:::!m [
= T
MUTOH VJ-626UE ] 5B English
YR o (@
5) ] 7 reyctn (13
i 6
7 | & Fi i
‘ ® V'Vlsu n 8 15
A ] 16
] T e %] 0
_: s‘f:p B ‘mm @g@i?
" L) | o 7 B A|OY
El= ) 8 = i alsja
Ready 18 X = 505.6,y = 76.6 75% NUM
1 File Menu Create a new file, load an edited file and save a file.
2 Option Menu Opens Language Setting menu.
3 Printer Setting Menu Opens Select Printer menu.
4 Ruler Menu Show or hide rulers.
Show or hide guides.
5 Choose Media— Choose the media size for printing.
6 Print Preview/Edit Switch the printable area between the print preview
mode and edit mode.
7 Print/Send to Layer Editor Displays the output destination (Print or Send to Layer
Editor) specified in the Output Mode Settings dialog.
8 Version Displays the application version.
9 Exit Exit the Layout Tool 2.
10 Printable Area Indicates the printable area with blue frame.
11 Zoom in Zoom in the printable area.
12 | Zoom out Zoom out the printable area.
13 Folder Tree Displays the folder tree to select a file.
14 Image File List Displays a list of image files to select from.
15 Image Preview/Text Edit Window Displays the Image Preview of the file selected from
13/14, or displays the Text Edit Window to insert text.
16 Insert the image/Insert or Update Text Insert the selected image to the printable area.
Insert a text.
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17

Edit Buttons

Displays the edit buttons.
For details, see
7-10 Align the image
7-11 Image Preview/ Text Edit Window.
7-12 Insert Text
7-14 Make Specific Color Transparent

18

Information Field

Displays the current mouse position and the zoom
percentage value of the printable area.

19

Print Mode Setting

Open the Print Mode dialog.
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7.2 Printable Area

The printable area is indicated with blue frame (10).

For origin in the Edit Area and print orientation, see 5.1.Change Origin Setting.
=]

File(E) Option Printer Setting Ruler

MUTOH VIJ-626UF

10

Printable area (blue frame)

Indicates the printable area.

Media size (bold green line) | Indicates the media size for printer driver.

Origin (green square mark)

Indicates
* print start position on the design
-origin in the Edit Area and ruler zero point.

In some printer models or print modes, the actual margin is not shown between the blue

frame and bold green line.

7.3 Information Field

The current mouse position

and zoom percentage value of the printable area are

displayed at the bottom of the Main Screen.

Width  254.0 =

T
Height 254.0 =
Scale 100 — A
18 |
U x=--1988y= 4178 30%
ay b
*Unit: mm

18

a | Mouse position

Indicates the exact X and Y position of your mouse from
the upper left corner of the printable area.

Zoom percentage

Indicates the current zoom percentage of the printable
area.
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7.4 Select Media

Click the drop-down list of 5 and choose the media size that you want to use.

1 ntited - Layout and Print Tool2
File(F) Opton Printer Settmg Ruler

&

M
™M
Lo AN
e . w0 @
)
8| | wmw - HlA|O|
E 2] Saale 0 8. A w‘ ‘
Ready

x= 18y =164.1 75% NUM

For Available Media Size, see 2.2 Printable Media Size

When selecting Custom Size from the list, the Custom Media Settings dialog appears.
Directly enter the width and height or click the up/down button to specify the value.

Custom Media Settings [ x|
Media Size Image Size
Width o mo Width 4730  mm
Height 584.0 : mm Height 3840 mm

Restore Defaults

Apply Cancel

For the printer models which automatically leaves margin, 5 mm from media
edges are not printable.
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7.5 Zoom Printable Area

To zoom the printable area, click 11 (+ button) to zoom in and click 12 (- button) to zoom
out.

|

_@

iofjic]

5

&

The zoom percentage:
25%, 30%, 35%, 40%, 45%, 50%, 75%, 100%
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7.6 Insert Image

This section explains how to insert an image to the printable area.
Select the folder of the image file from 13. The list of image files will be displayed in 14.

Use one of the following methods to insert the image.

a. Double-click the file in 14.

b. Drag and drop the image from 15 using mouse.

c. Click on the image file in 14 and then click 16.

d. Directly drag and drop files from Explorer (You can insert multiple files).

© Untitled - Layout and Print Tool2
File(E) Option Printer Setting Ruler

= Ml Desktop
G Libraries
4 English
4 8 Computer
4 € Network
48 Control Panel

& Recycle Bin

Image.jpg

s e 2] ] €

=y, B AL

g Height 2540 :: %‘ A‘ Q]

E 7J Scale 100 Tix ﬂ E

x=99.7y = 4322 75% NUM

To edit an image file in graphic software, right click on the folder in 13 and click Open to
open Explorer.

-l Desktop | YT
i Open

oI Properties
-l Metwork
w58 Control Panel

& Recycle Bin
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7.7 Resize & Move Image

To resize or move an image, click on the image so that corner handles appear on each
corner of the image (shown in red box below). If multiple images are inserted to the
printable area, click the image that you want to resize or drag.

To increase or decrease the size, drag a corner handle away from or toward the center
of the image so that a gray line appears to indicate the resized image size.

A

To move an image, click on the edge of the image (except corner handles) and drag to
the area you want to move. A gray line appears to indicate the moved location.
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7.8 Image Edit Menu

The edit menu appears when you right-click on the image in the printable area.

Five editing functions are available; Delete, Zoom to 100%, Bring to front, Send to back,
Original Image. When more than 1 image is inserted to the printable area, “Bring to
front” and “Send to back” functions will be valid.

Zoom to 100%

Bring to front

Send to back

Delete the guide

Original Image

UNDO (Ctrl+Z)
REDC (Ctrl+Y)

Delete Delete the image you selected.

Zoom to 100% Restore the zoom to 100% after rescaling.

This function is valid when you inserted more than 1 image
to the printable area.

To bring the image to the front of layering images, right-click
on the image and click Bring to front.

Bring to front

This function is valid when you inserted more than 1 image
to the Edit Area.

To send the image to the back of layering images, right-click
on the image and click Send to back.

Send to back

When you insert a larger image than the printable area, this
image will be interlaced (decrease its resolution).

To display the image with its original resolution, check
Original Image.

Original Image Interlaced image Non-interlaced image

Criginal Image v Original Image

Amsterdam | Amsterdam

You can undo or redo a last editing action.

Right-click on the image to select Undo or Redo. Or undo
by pressing [ctrl] + [z] keys, redo by pressing [ctrl] + [y] keys
as shortcuts.

Undo / Redo
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7.9 Print Preview Mode/Edit Mode

Switch the printable area between the print preview mode and edit mode.
To switch the mode, click 8 Print Preview/Edit Mode.

Use the edit mode to edit an inserted image. After editing, click 8 to change the
printable area to print preview mode to see how the design will look when you print it.
In the print preview mode, you cannot edit the image.

If you want to switch back to the edit mode, click 8 again.

{© Untitled - Layout and Print Tool2 )
File(E) Option Printer Setting Ruler
Name
Imagejog
Fosition o |
wn 00 [ P A D)
Top 00 *mm ~ |
R
wam 00 8 1
|
B | veme o H A|Of
g Scale 0 g A E_ ‘
Ready x= iy =381 7% NOM
{© Untitled - Layout and Print Tool2 =) e
File(E) Option Printer Setting Ruler
5 B Desktop " [Name
5 %4 Ubraries
- image o9
5 Engish
o 188 Computes
o
4 8§ Control Panel
& Recycle Bin
m
[
N
Position ‘
= mm = |
Top -
| 5]
viatn o =
| NE®;
B | eon . ‘ |
B} Scale s A ‘
x= 6By =357 7% NOM
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7.10

Align the Image

Align the image placement with 17 Edit Buttons.
The Position and Size values below nre equivalent to fhe actual print position and size.

e D T aml

: mim
a =
Top 0.0 = mm &‘ / &
Size ] ] m ]
Width 0.0 = T 7
Height 0.0 = o ﬂk ] O ]
| Yo
AT !
Displays the image position from the upper left corner
a | Position *1 p Y gep PP
(editable).
b | Size *1 Displays the image size (editable).
Displays the scale of the selected image.
Cc | Scale *1 You can directly enter the scale value to change the scale
of the image.
Vertical Align Center *1 Aligns the images to vertical center.
e | Horizontal Align Center *1 | Aligns the images to horizontal center.
. ) Optimizes the image to the largest size such that fits
f | Fitto Printable Area ) o i i
entirely within the printable area and centers the image.
g | Scale up *1 Scales up the inserted image.
17 h | Scale down *1 Scales down the inserted image.
. . Clears all inserted images.
i | Clear the image . . . .
The confirmation dialog will appear.
Displays the grid lines in the printable area.
The following 3 mesh views can be switched by clicking
this button.
j | Mesh View
Mesh 1 Mesh 2 Mesh 3
k | Flip Horizontal *1 Flips the image horizontally.
| | Rotate Image *1 Rotates the image by 90 degrees with each clicking.
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17

Image Preview/ Text Edit
Window

Switch between Image Preview and Text Edit Window.
For details, see 7-11 Image Preview/Text Edit Window.

n | Add Transparency

Make specific color transparent.
For details, see 7-14 Make Specific Color Transparent.

0 | Crop/Reset

Crop a specific area from the selected image.
For details, see 7.15 Crop Image.

*1 When more than one objects are selected using the mouse, the function is applied to all the

selected objects.

To select all objects in the printable area, use the Ctrl-a keyboard shortcut.
To select more than one objects using the mouse, see 7.31 Copy and Paste Object.
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7.11 Image Preview/ Text Edit Window

Switch the data to be edited between the Image Preview and the Text Edit Window by
clicking the Image Preview/ Text Edit Window button in 17 Edit Buttons.

When switching this pane, the icon shown on the left bottom of this pane and on the
button will also be changed.

o | {H DO
SN
Vi \

Image
Preview

G| & &1

Image Preview
Button

Fa
40p
=

|
Al Bl
Vi N

e

Text Edit Window
Button

Text Edit
Window

e}
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7.12 Insert Text

Click the Image Preview/Text Edit Window button to switch this pane to Text Edit

Window.

In this menu, you can enter text, select font, and insert or update it into the printable

area.

15

+ AY

A=A

Text Entry Box

Enter text you want to insert to the design.

b | Font Settings

Click here to open the Font Settings Dialog.

¢ | Insert/Update

Insert the text to the printable area or update the text inserted
to the printable area. This button will be enabled, when you
enter text in the Text Entry Box.

Windows Font Settings

Click b. Font Settings to open the Font Settings Dialog.

Available Windows fonts will
be listed in the Font option.

ont style: Size:

bde dium 42 ak,
T -

Iiedium Ohlioue 18

8
—| Bald 36 [=]
. 48 —
Fold Obligue - | oo _
Effect Sample
I:‘Stril_«eout (—
Dgnderline %Mdé (
Color:
IE ack - Script:
‘e ztern -
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If you cannot find a Windows font you want to use from the list, follow the procedures below
to show the hidden font.

Control Panel — Appearance and Personalization —p  Fonts

s [E=8(EcR =]
G@v@ » Control Panel » = [ 43| [5<erch ControtP.. 0| @O.\\, ¥ Control Panel » Appearance and Personalization + ~ %2 | [ Search Control P P |

Adjust your computer's settings Viewby: Category ™ Cortrol Panel Hopgg E Persanalization

! Changethetheme | Change desktop background | Change sound effects

System and Securil
& & Change screen saver

gy  Systemand Security User Accounts and Family Safety Network and Internet .
13 Review your computer's status &) Add or remove user sccounts Hordware and Sound ! Display
Back up your computer &) Set up parental controls for any user . ®  Make text and other items larger or smaller | Adjust screen resolution
Find and fix problems - — rograms Connect to an external display
Appearance and Personalization User Accounts and Family
Network and Internet &w( Change the theme Sotety [ Desktop Gadgets
@. View network status and tasks Change desktop background O Q] —E'  Add gadgets to the desktop | Get m:‘v,e gadgetsonline | Uninstall 2 gadget
- Choose homegroup and sharing optians Adjust screen resolution Personalization Restore desktop gadgets installed with Windows
|/ Hardware and Sound Clock, Language, and Region Clock, Language, and Region i Taskbar and Start Menu
ﬁ View devices and printers g Change keyboards or other input methods Ease of Access Customize the Start menu | Customize icons on the taskbar
Add a device Change display language Change the picture on the Start menu
=7 Programs %W FEase of Access @. Ease of Access Center
h 4 [ ) Let Windows suggest settings F' nccommodate low vision | Use screen reader | Tum on easy access keys
4 Uninstalla program ‘J Turn High Contrast on or off

Optimize visual display

‘ Folder Options
Specify single- or double-click to open | Show hidden files and folders

Fonts
h Preview, delete, or show and hidefonts | Change Font Settings
Adjust ClearType text

Click Fonts.

iy =]

Preview, delete, or show and hide fonts | Change Font Settings
Adjust ClearType text

or
Start Button =% Computer —» Local Disk

—Pp  Windows —p  Fonts

Local Disk (CH .
— 5l l l | Windows
R GE free of =R -

Double-click Fonts to open the Font folder.

-,
@u'| v Computer » Local Disk (C:) » WWindows »

Organize « Include in library - Share with = Mew

w0 Favorites h Fonts
B Desktap
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The Font folder stores all installed fonts including the hidden (transparent) fonts.
The hidden fonts cannot be used for common applications.

Preview, delete, or show and hide the fonts installed on your computer
Organize v = v
Abg Abg Abg ]
Jasming! UPC JEANETTE Jokerm Juice ITC Regular  KaiTi Regular Kalinga KANTOR
Medium Regul Mediurn
Abg Abg Kby
Kartika KEAGAN KEITH Medium Khrer U KINDLE Medium KodchianglPC Kakila
Medium
A A "7
bg || «z 7 Az
Kristen ITC. Kunstler Script LANCE Medium Laa UL Latha Latin Wide Leelawadee
Regular Regular

To show a font, right-click the icon and click Show.

Ebrirna

Open
Qpen in neww vind o
Copy

Delete

Prewview

Print

Showe

Check the list.

>

The font icon appears.

Abg

Ebrirma

The font appears in the list.

Font
Font: Font style: Size:
P dium 432 ok,
T
26
m
36 |§
. EE
Eold Oblique e
Effects Sample
|:|Stril:eout (—
Dgnderline %Mﬂé (
Colar:
B Eack Seript:
Weztern -

® Having too many fonts in the list can slow down some application performance.

Font:

DORO THEA]

Ebrirna | 2]
Dotorctims G TE
Elephant -
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The following procedures describe how to insert a text to the printable area.

Enter your text in the Text Entry Box.

ABQ

+A

AA

Click Font Settings to display the Font Settings dialog and change the font style.

ABC

AA

Font B
Font Fant style
Feeoe U] Regular oK
Segoe Ul EYRRegular -

Segoe LI Symbol ftalic (=

SHOT (| |semibold
SHOWCARD GOTHI - | Bold - | |
Effects Sample
[ strikeout

# [] Underline
Color:
[Jwhite - Soript:

Western -

After changing the font style, click Insert/Update to insert the text to the printable area.
Use 17 Edit Buttons to scale up/down or move the text as editing the image.

5 Untitled - Layout and Print Tool2
File(E) Option Printer Setting Ruler

[= ©
<}:'|un A A

Q@

. o B

w B B
Bl | e s L 4| O
g Scale 100 % %

x=4764y=431.3  75% NUM
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To update the text, enter a new text in the Text Entry Box and click Insert/Update.
Before clicking, make sure to select the target text in the printable area.

) Untitled - Layout and Print Tool2

=[5 -
Filo(E) Option Prnter Setting_Ruler

T 2 ][] @
. o B A e

8| | s - H|a| O

L Bl | = 5 @ B

To change the color of font, go to the Font dialog to select the color you want.

Colors
Ak X

FAYhED: ZFAIAD: HA(: Standard - Custom
[¥u Gothic U]

i
U Gothic Ul ~| ik

A-TUA

Fovtl

Y
OmyELEK
BT

# New
B(0:
n FasHDE XFEYHRY

Current
Click Font Settings to change the font style.
@ Untitied - Layout and Print Tool2 (= C

123

< ——oi[A oA

Roit a
s, B H @
Top 37 8o §I|'5 W\‘
Width 1962 %

o 552 | A| O

sale w0 [y E

x=3889,y= 1609 T5% WM

o [®
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If no text is selected in the printable area, a new text will be inserted by clicking

Insert/Update.

(@ Untled - Layout and Print Tool2
File(E) Option Printer Setting Ruler

[ESRE X

123

<::']IIII1 A

Ready

© @

X=3584y=4233  75%

AA

lef 00 H o i ﬁﬂ

o T | A
i 8| A| O
Scale 100 :% E E

UM

Image and text can be edited at the same time.

@ Untitied - Layout and Print Tool2
File(E) Option Printer Setting Ruler

MUTOH

J

MUTOH VJ-626UF
ing

i

= (=) -

+A A=A
s s B 1@
Top 104 Epn mol po| s
5| 5 o

Wi 1500 &
@; Height 1083 & E M g
‘} sale w0 2y g E
X = 405.4,y = 156.1 75% NUM
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7.13 Ruler and Guides

You can place rulers and guides from the Ruler menu.
Once the rulers appear, they will remain at the next boot.

@ Untitled - Layout and Print Tool2 = | -
File(E) Option Prnter Setting Ruler

st
= B Desitop Name

s 0 15 = 25 £ 3 “
T L1l T Lo L1l P R
i Libraries

& Recycle Bin

[
z e e BT @
] w O B B
] 8l | s - B A|O

o~ < almg

X 4097y = 3607 75 NUM

al

The image data can be saved including guides setting with .lad file. When you insert the
file into the printable area again, the guides will appear on the image. You can also save
the guides setting without image data to use as template file.

Use the guides as follows:

As a Mark:
-Position a one-point mark or text
-Indicate a print start position for a user defined template
-Indicate a tag position on the media.

Measure Spacing:
-Measure each spacing to see the actual text size.

0 5 10 15 20 25 30

II[I|IIIIIIIIIlI|I||I|IIII

e

213:1

[ I
[
o
]

10 |
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A) Rulers
Check Ruler to show rulers.

& Untitled - Layout and Print Tool2

File(F) Option Printer Setting [Ruler]

Ruler

Lock guides

Show intersection
Guides 3

® Depending on the scaling of printable area, scale on the rulers varies as follows:

Scaling of printable area Scale on the rulers
Less than 30% 50mm scale
More than 30% 10mm scale

B) Guides

You can place up to 10 guides for both vertical and horizontal guides.

Choose either of the following procedures to insert guides and drag to the appropriate
position.

-Left-click the rulers and drag within the printable area.

s 10 15 » i s 10 15 20 =
L1l I Ll TN T N ST AR 1Ll [ AR

2 | b

i L ALl g i i
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= Specify guides from the dialog.

int Tool2
itting | Ruler
v Ruler 10

Lock guides ||| | ]|

v Show intersection
Guides b Insert
_‘ I Delete all

Choose Ruler > Guides > Insert.
The Guides Option dialog will appear.

Choose Horizontal or Vertical guides.
Specify spacing from ruler's zero origin.

Guides Option @

Choose guides and specify spacing in 0.1mm
increments. M

@ Horizontal guides

() Vertical guides
0.0 mm 1 Show from opposite of
origin
[ OK ] [ Cancel ]

b

If you close the Guide Option dialog and open it again, a new guide will be added to
10mm below or right from the guide you previously inserted and the position of the
new guide will be displayed on the dialog.

To change the ruler's zero origin to the opposite side, check Show from opposite of
origin.

The guide shows in red while dragging (before releasing the mouse button).

60



Layout and Print Tool 2 Operation Manual

C) Measure Spacing
The spacing between each guide is displayed.
This display is only available while the rulers appear.

0 S 10 15 20 25 30

|IIIIIIII|IIII||III|IIII|IIIII
21331

o

v

-
o

To show the position of the guide intersection, check Show intersection.

:d - Layout and Print Tool2

Option Printer Setting [Ruler]
v Ruler 10
v Lock guides |
v Show intersection

Guides 3

TOH VJ-626UF o

Print Mode Setting | (1030, 100.1)
10

D) Delete the guides
To remove a single guide, right-click the guide and choose Delete the guide.

Delete

Zoom to 100%
Bring to front
Send to back
Delete the guide

Original Image
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To remove all guides:
Choose Ruler > Guides > Delete all.

rint Tool2
etting | Ruler
v Ruler 10
Lock guides | | | [
v Show intersection

Guides b Insert
_‘ I Delete all

E) Lock the guides
Once you place the guides, lock them to block from the accidental mouse click.
xd - Layout and Print Tool2
Option Printer Setting [Ru_ler]

v Ruler 10

v Lock guides | |
v Show intersection

Guides »

TOH VJ-626UF gl
Print Mode Setting = (1030, 1001)
10
You can save the guides setting in the file.

When you open such files, the guides will be still locked.
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7.14 Make Specific Color Transparent

This is the simple function to edit an image.
You can remove a solid color from the entire image to make it transparent.

Example:
Image Print Image -

Make the background transparent

Q_p
de apD

(NoTED

® \With this function:
- Intended objects may not be fully removed
- Unintended objects may be also removed.
For the better results, we recommend you to edit an image from graphic application.
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Click the Transparency button. The Transparent Option dialog will appear.

Position o
Left 0.0 - mm * _u— ng
Top 0.0 S mm @ E‘ N
Size mw
Width 0.0 mm ’
Height 0.0 mm Ak Ol
A Scale 0 ¥ o ﬁl J
o Rk
- a B W
fe " HAO
f< A =]

The transparent options are not available unless you select an image.

Transparency Option lﬁ

@ Use original color
Enable transparency
Red : Green: Blue: Target color
0o o & o
Color tolerance

0

[ Apply ] [ QK ] [ Cancel ]

You cannot remove a color from the text inserted by Layout Tool 2.
Change a color or text message from the Text Edit Window.

Check Enable transparency and click color that you want to make transparent from
the printable area. Your specified color appears on the dialog as Target color.

e - Libraries
- A English
-8 Computer
-4 Network
-8 Control Panel
& Recycle Bin

~
Transparency Option =5

(@) Use original color
@ Enable transparency

Green: Blue: Target color
222 = o

Color tolerance

0 =

(appy ] [ ok ] [ concel ]
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You can specify the acceptable limits or color tolerances from the target color.

() Use original color

@ Enable transparency

Red : Green: Blue: Target color

222 0 & o [2

Color tolerance

0 =
| Apphy | [ OK ] [ Cancel
Example:

Specify a solid color (color tolerance = 0):
Transparency Option ﬁ |

(L) Use original color
(@ Enable transparency
Red : Green : Blue : Target color

4 = 132 5 242

Color tolerance

q =
Apply ‘ OK Cancel

Specify color tolerance (color tolerance = 20):
I'Tn:‘msr:nareno,‘ Option E.‘

R P () Use original color
(@ Enable transparency
Red : Green: Blue: Target color
O @ w (12 e e
 m— |

Color tolerance

20

apply | [ ok Cancel |

65



Layout and Print Tool 2 Operation Manual

7.15 Crop Image

If you want to use a specific object in your image, use the cropping tool to easily crop
the area you want to use.

Example
Before cropping After cropping

(@) How to crop a specific area
Keep the image selected and click the Crop/Reset
button.

2
ap
o

+[a]

Position
Left 10
Top 952
Size
width [3101 |=

0|0 8|

> ¥ HF
R S

Height  |253.7 =
Scale (222

Switches to Crop Mode on the selected image.
The Crop (+) and Reset (-) buttons appear.

—Laa)
+[2a]

Position
Left 0.0

Top 94.0

Size
Width  [310.0 =

Height |253.6 z

Scale 222
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Drag on the image using mouse to choose the
cropping area. The selected area is marked in
dotted frame.

+[ae]

Position
Left 0.
Top 94
Size
Width |31
Height | 25
Scale 22

C)

Click the Crop (+) button to confirm the cropped area and exit Crop Mode.

v

Position
Left 0.

Top 94

Size
Width |31

Height 25
Scale 22

The cropped area is displayed in the printable area.

m = -+-!!Il

[Position
Left 61.1
Top 204.3
Size

width  [168.3
Height [61.0
222

LoJlic’]
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(b) How to reset the crop
Select the cropped image.

61.1
204.3

168.3

9
8.

The Reset (-) and Crop (+) buttons appear, but only the Reset (-) button is enabled.

61.0

222

|°_
[CECIE .
: g aA
Position —
Left 60.8
Top 207.1
Size ﬂ
g width | 162.0 ﬂ
Height | 542 +
g Scale 222

Click the Reset (-) button so that the original image will appear.
Then, click the Crop/Reset button to exit Crop Mode.

0.0
94.0

300 [
2536 |-

222
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7.16 Print Mode

Click Print Mode Setting to display the following dialog.

Color balance adjustment and ink density adjustment are available from the dialog.

® For the functions of 'Apply Layer 1 print mode setting’, see 6.4.1 Multi-Layer Printing

Print Mode
Apply Layer 1 print mode setting
Profile LUH1
Print mode dialeg value |
Layer 1 Setting k )
. Save
(O Select print mode file ||nitiaISetting Reload when loading
Jadrm &
(®)i5pecify print mode setting b )
Color Printing
Color Balance Color Balance b )
a OFast Red: I + EI Saturation: = I + EI
(®) Fine
Green: I + EI Contrast: I + EI
() Super Fine
Blue: I + EI Brightness: I + EI
o Color Correction amma: . : .
M} ne Color Comecti d G 01 22 10
White Printip p
justment % High-Densi clor Balance
Cc k Ad 100 g ity Color Bal b
Fast
\a_j(; o \@ Chokeedges  []Spread edges | 0.1 f Contrast: - I = EI
O SupsrEine Enable gradation Brightness: I . EI
! hite in th -alpha ch |
gnare white in the non-alpha channel image T 0 22 0
e
Printir d Under coating O All area @ Image only h )
Varnish Printing
Ink Adjustri d ) %  []High-Density Color Balance b )
a () Fast
/ ] [IChoke edges [ Spread ecin-memm—mis f mm T _ I . E
(@) Fine g
Enabl dation s
Osupey—, JErblegradtin c) Brghtness. - i - [
Ignore white in the non-alp! nnel image [] Glossy Finish
amma: B - B
e G 01 22 1.0
Printing Over coating CAllarea (@ Image only
Head Gap (® Normal (O Large h) Restore Defaults Apply Cancel
L\ 0 )}

J

*To adjust settings in b, drag each slider.

a | Print Quality Choose between Fast/Fine/Super Fine.
zed Adjust color balance for each color.
reen
b | Blue Set the value between -20 and +20 (in increments of 1).
) Adjust saturation of the output images.
Saturation o
Set the value between -20 and +20 (in increments of 1).
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Adjust contrast of output images.

Contrast .
Set the value between -20 and +20 (in increments of 1).
i Increase or decrease brightness of output images.
Brightness .
Set the value between -20 and +20 (in increments of 1).
Optimize the brightness in the midtones.
Gamma o
Set the value between 0.1 and 2.2 (in increments of 0.1).
Use for white or varnish printing.
Enable If checked, convert a color image to black and white (2-tone) image and
_ print it with white ink or varnish.
gradation i . . . . .
If unchecked, print a solid white underbase or varnish over-coating without a
gradient of image.
Adjust the ink density.
Ink density: 10% Ink density: 100%
Ink
Adjustment

A

Ignore white in
the non-alpha
channel image

If checked, recognizes white objects as transparent objects in a non-alpha
channel image.
Original image

aQ_p
deap

Unchecked Checked

Choke Edges/
Spread Edges

Scale the outline of white or varnish layer by 0.01mm increments.

Check either one of them and specify the amount to choke or spread the
outline.

® Spread Edges function uses the ink density specified in the Ink
adjustment field (d) to increase the outline. If you want to
increase the edges of patterned image, use graphic software to
edit the image, and then use it with Layout Tool 2.

® This function can enlarge even tiny points which are hardly
visible. It may cause unintended results especially with JPEG
image. Please perform test print before using the Spread
Edges function.
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Use for varnish printing. (Not available for VJ-426UF)
Apply the glossy finish over the printing.
When this option is checked, following settings will be automatically

Glossy Finish | selected. If needed, change the Ink Adjustment setting.
Print Mode Fast (Fine and Super Fine are not available)
Ink Adjustment Ink Adjustment: 35%, High-density: Enabled
Use for white or varnish printing.
Specify the printing area for automatic white underbase and varnish
over-coating.
All area/ i . . L
Image onl All area: Print the white underbase and varnish over-coating in the same
g y area as specified in 6.2 Media Size Setting.
Image only: Print white underbase and varnish over-coating only under/over
the image.
Restore i
Restore to the default setting.
Defaults
Opens the Open/Delete dialog to select the saved Print Mode settings or
Open/Delete ) )
delete unwanted Print Mode settings.
Save Save the Print Mode settings.
No Color . I
) See No Color Correction Printing on the next page.
Correction
Select Large when printing on uneven media that distance between the print
Head Gap head and media surface varies from place to place. However, print quality
may decrease with Large setting.
Print white or varnish with high density.
High-Density | When this option is checked, the selected white or varnish layer is printed

with double density (print speed will be decreased by half).
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No Color Correction Printing

When you want to use the primary color of the ink to print your image, select this menu.

Celor Printing

Color
() Fast
(®) Fine
() Super Fine
| [¥INo Color Correction |

The table below shows the RGB values of each primary ink color.

Ink Color RGB values
Black (%, X, x) all same value
Cyan (x, 255, 255)
Magenta (255, x, 255)
Yellow (255, 255, x)

® |[f you print an image data using No Color Correction, mostly the color of the prints look
different from the original image data.

® When this setting is enabled for Color printing, the following confirmation dialog will
appear.

LayoutAndPrintTool2 [ x |
'Ne Celer Correction’ is enabled for the layer
Do you want to continue?

Layer 1

Frtil
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7.17 Print

When finished editing, click 7-Print. The following dialog will appear.

7.18 UV Flatbed Printing

Choose Print Mode

Choose the print mode you want to use

a
’ @ Print all valid layers

Print with the specified color mode.

b B Print the selected ayer
Maormal Printing/Layer Printing/Sub Area Box

C
. ot
d Print Angle Adjustment

Printing

Cancel

Print all valid Layers

Print the selected layers with multi-layer printing by specified

color mode.
i Print the selected layer by automatic coating printing.
b | Print the selected Layer i )
Opens the Choose Print Mode dialog below.
¢ | Print Angle Adjustment See 7.20 Print Angle Adjustment.
) , The green check mark v appears when Print Angle
d | Adjustment valid mark ) d i i PP g
Adjustment is valid.
d ) Cheoose Print Mode E
" Choose color mode.
Print one page with the specified color mode setting
e ) [ Coalor
T [IWhite
[ varnish
Sub area box printing
["]5ub area box - Black
Cancel
d | Choose color mode Check the color mode you want to print for automatic coating printing.
L Check Sub area box to print sub areas created in the printable area.
e | Sub area box printing

Choose black, yellow or white for sub area box printing.

For the details, see 6.4.2 Automatic Coating Printing, B) Print and C) Sub Area Box Printing.
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7.19 Roll Printing

Choose Print Made X
Choose the print mode you want to use
a J? Color Printing
Print with the specified color mode.
—> Print the selected layer
b Mormal Printing/Layer Printing/Sub Area Box Printing
c MNumber of copies: El =
d | Print Angle Adjustment | Cancel
a | Color printing Print with the specified color mode.

b | Print the selected Layer

Print the selected layer by automatic coating printing.
Opens the Choose Print Mode dialog below.

Specify the print destination to Layer Editor from the Output
Mode Settings dialog before clicking this mode.

¢ | Print Angle Adjustment See 7.20 Print Angle Adjustment.

d | Adjustment valid mark

The green check mark v appears when Print Angle
Adjustment is valid.

@ ‘hoosePrint Mode X
Choose color mode.
Print one page with the specified color mode setting
[ Coler
/ [ White
Sub area box printing
[15ub area box - Black
Number of copies: =

e | Choose color mode

Check the color mode to print the selected page.

f | Sub area box printing

Check Sub area box to print sub areas created in the printable
area.
Choose black, yellow or white for sub area box printing.

For the details, see 6.4.2 Automatic Coating Printing, B) Print and C) Sub Area Box Printing.

74




Layout and Print Tool 2 Operation Manual

7.20 Print Angle Adjustment

The Print Angle Adjustment menu allows you to correct the print start position and angle
of an image to match to the angle of media on the table.
Once specified, you can save this setting to use it again.

® This function intentionally changes the print start position or rotates the image. If the
image exceeds the printable area, it will be clipped.
® When this function is enabled, the printer takes more time to start printing an image.

To use this function, uncheck the No Adjustment checkbox.

Print Angle Adjustment X

Position Adjustment

Top/Bottom Top 0.0 2 mm

Left/Right Left 0.0 = mm
Angle Adjustment

b 00 Jmm W 3840 - mm
Ao Adjustment

Save Open Apply Cancel

The blue arrow in the preview indicates the print start position on the printer.
By using the buttons appeared in the lower part of this dialog, you can save the print angle
adjustment setting specified in this dialog, or open or delete the saved setting.

Print Angle Adjustment X

Position Adjustment

Top/Bottom Top ~

Left/Right Left v i

Angle Adjustment

2

i
L

Save Open Apply Cancel
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Open/Save/Delete Print Angle Adjustment

If you want to save the setting specified in the Print Angle Adjustment dialog, click Save
in the dialog. The Save As dialog appears to save under a new fine name.

Save As =

File name

|JIG No.1

Save Cancel

To open the saved setting, click Open in the Print Angle Adjustment dialog so that the
Open/Delete Print Angle Adjustment dialog appears. Select the file from the dropdown
list, then click Apply.

If you want to delete the saved setting, select the file and click Delete.

Open/Delete Print Angle Adjustment ot

Print Angle Adjustment File

NG MNe.J1 ~

Delete Cancel
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Position Adjustment

Select the position of the image from the Top/Bottom and Left/Right dropdown lists and
enter the amount to shift the image respectively.

According to the input value, the preview on the right shows the degrees of position
correction.

Example Pasition Adjust

Top/Bottom

|

Position Adjustmept

Top/Bottom

Left/Right Left w i

Angle Adjustment

To rotate the image to match to the angle of media, measure the width of image printed
on the media (W) and distance between the printed image and media at right angle to
the image (D). Enter the measured values to D and W input boxes in the Angle
Adjustment field respectively.

According to the input value, the preview on the right shows the degrees of angle
correction.

(See the area shown by the blue dotted line.)

Angle Adjustment bessssssssssssssssseanaan

. . : -35 5

p |00 ~mm W [3840 - mm E -1: = 1 -
example Angle Adjustment

R P o

Angle Adjustment

0[5  [lem w [0 [
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7.21 Save and Load the file

Save and load the file from the File menu on the Toolbar.

The edited image data, platen size and image position are saved into the file. The
saved file can be loaded for printing/editing again.

& Untitled - Layout and Print Tool2

File(F) | Option Printer Setting Ru

New(N) Ctrl+N
Open(O)... Ctrl+0
Save(S) Ctrl+5
Save as(A)...

Lock Image(L)

Recent files

Exit(X)

The edited file will be saved as file extension .ladm.

(O save as =)
@Q.\@ » Libraries » Documents j v|&,\| Seard ent:

Organize v New folder =~ @

Jr Favorites — Documents library —
1§ Downloads Includes: 2 locations
s Name ) Date modified Type —
% Recent Places
i Libraries
[Z Documents
&) Pictures
B videos

&) Music

8 Computer
&, Local Disk (C:) ~

File name;_Untitled.lad -

Saveas twa [LayoutandPrintTool2 Files (*Jadm) | -

® \When you use multiple images or large images, make sure there is enough space on
your target disc.
® \When an image is locked, the following icon appears at the bottom left of the printable
area.

0

) of
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7.22 Language Setting

To select a language, go to Option > Language Setting.

l@ Printer Setting  Ruler

Language Setting

Media Profile Management -
Change Background Color

Printable Area Setting

The Language Setting dialog appears.

Language Setting x

English w

ey ] | Concel

Japanese or English is available.
Select a language from the drop-down list and click Apply.
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7.23 Printable Area Setting

To print more than one image at equal distances on the same media, go to Option >
Printable Area Setting to create sub area. You can add different image to each sub

area.

Option | Printer Setting  Ruler

Language Setting
Media Profile Management
Change Background Color

| Printable Area Setting |

The Printable Area Setting dialog will appear. In this dialog, you can specify the position,
size and number of sub area to create on your media.

Change printable area setting.

Printable Area Setting

Specify margin, printable area size and number of printable area.

aj Media being loaded

Width 473.0

Height 318.0 mm

Laycut Informatien

Distance from print start position

Left 0.0 = Top

~| mm
C) Margin between printable area

Left 0.0 = mm Top

Sub area box size

dj Width | 473.0

.ej Height [319.0 = mm

U Rows 1 = \g) Columns

1

0.0

0.0

\hj Preview

i /[ ]Duplicate image

Preview

</

k
Restore DE‘FauItN)

Cancel
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Media being loaded

Displays the size of media selected in the main screen.

Media being loaded

|:> Width | 482.0
mm
Height 5820 mm

Margin  from  print
origin

Specify left and top margins from print origin (print origin. = upper left
corner). (*1)

Margin between
printable areas

Specify the margin between sub area in rows and columns.

Width Specify the width of sub area.
Height Specify the height of sub area.
Rows Specify the number of sub area in rows.
Columns Specify the number of sub area in columns.
By clicking () Preview, sub area specified in (@ through (@ is
Preview

displayed in (0) Preview.

Duplicate image

Duplicate the same image in sub area for a specified number.

Preview

Click Preview to update (@) Preview.

Restore Defaults

Click Restore Defaults to restore to the default setting.
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How to specify Printable Area Setting

1) Specify (@ Width and (&) Height of each sub area.

FY

Wiagtt 2000 =

i 2000 =
Heigt ' mm

*To see the actual size of sub are on the media, click Preview.
-Preview

Preview
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2) Specify the number of sub area to create in @ Rows and @ Columns.

2 Fy

-

S
Rows 2 = Columns

-Preview

Preview

3) Specify @ Margin from print origin and @ Margin between printable area.

Margin from print origin

Left 250 — Top 250 = nm

> | Mmm

Margin between printable area

Left 30 2 Top LTI .

-Preview
The print origin is located in the upper left corner.

@ Margin between printable area specifies the blank space between each sub area.

Preview

Print "=—) |

origin
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4) After specifying all the settings, click Apply. The sub areas specified in the Printable Area
Setting will appear in the printable area.

9 Untitied - Layout and Print Tool2 >
Fie(E) Option Printer Sewing  Ruler
e s 0w 15 m B W » & & ® » w & 0
Lol b b b b b bese b b Do b Do B b =
10
15 1
20 ]
5
30
%7
= Gl
1 L[]
45 Position o
e 00 i, | | @
| Top 00 -
e N
LE & 5| @
3 wiem o0
= B | e .- B A|O
A= =
g = B | =0 G Al O
P
X=SeiAy=SHE  S0% WM

5) To insert an image or text into sub area, light click on a sub area you want to insert. Then
choose an image or text and click Insert/Update to add it to the sub area.
You can also add an image to each sub area by drag and drop.
-Left click on a sub area - After choosing an image or entering
text, click Insert/Update.

A

i =

-The inserted image or text will be displayed on the Edit Area as follows:
Image Text

o m o om om owmom i s s owm s m x m ® w® %
Lo b bl b by b i by S FETHARTATA ATATA STRR] ARTRN FUNRE FRUNL AAURY ARAUA N

: i1
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6) Repeat Step 5) to add image or text to each sub area.

) Untitled - Layout and Print Tool2 =l =)
File(F) Option Printer Setting Ruler
0 5 10 15 ) 2% 0 35 40 45 50 55 L [ 70 75
= M Deskt
Lo bonc b oo e Do b b b Do Do D Do Do L -‘lez_in L
5[ English
{8 Computer

€ Network
5 8 Control Panel
& Recycle Bin

1
3 .

Position

25 ]

E
L1

]

] Left 00 -
| Top 00
50
] Size
] Width 00

@

Height 0.0 2 m
ﬁ| seale 0 e

x=5834y=5356  50%

> (8
> [w |%
mlofwle

2
L
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Duplicate Image

If you want to duplicate the same image in sub area, check 'Duplicate image' and
specify the number of sub area. This setting is reflected in all layers.

The same image will be printed for the specified sub area.

Printable Area Setting [ x|

Change printable area setting.
Specify margin, printable area size and number of printable area.

Media being loaded Preview

Width 473.0
mm

Height | 319.0 mm

e 7/% _

Margin between printable area

Left 0.0 = Top 0.0 =

Sub area box size

widh  [1100 5]

Duplicate image 5

Height | 1000 =

mm
Preview Restore Defaults
Rows 4 = Columns |3
H Cancel

Printable Area Print Preview

o 5 5 0 45 g 2 @ as

3 5 1w 13 0 0 ] 5
TN S I A B I S T ' N S N R E
o]

wsp E) ) E) dJasb Jasb deab dasb
g g P s

f 10 5 2
P I WIS I |
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7.24 Temporarily Change Background Color

You can temporarily change the background color of the printable area.
The background color will be restored to default at the next boot.

Before change (default)

After change (example)

[t} 10 20 30 40

10|

20 |

30 |

o 10 20 30 40 5

10|

20 |

30 |

Go to Option > Change Background Color.

Option | Printer Setting  Ruler
Language Setting
Media Profile Management |

Change Background Color
Printable Area Setting

To specify the color, use the red/green/blue sliders or click Choose Color button.

Temperarily change background color

Red

Blue

Choose Celor

Apply

Reset to Default

Cancel
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7.25 Add Media Profile
If you want to add media profile, follow the procedures below:

Choose Option > Media Profile Management.

Option | Printer Setting  Ruler

Language Setting
I Media Profile Management I L
Change Background Colar

Printable Area Setting

When the media profile dialog appears, click Add to add a new media profile.

The default media profiles are not displayed in this dialog.
rMedia Profile Management g‘

Add [ Remove | [ cose |

You can remove a media profile from this dialog.
Media profile can be added or removed from both printer driver and Layout Tool 2, and
once added, it will be available in both software.

The added profile can be selected from Print Mode > Profile.

nnnnnnn

sssss

nnnnnnnnn

nnnnn

® Media profiles for Layout Tool are already stored in the printer driver and Layout Tool
2.
® Layout Tool 2 cannot use Non-Mutoh media profiles.
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7.26 Select Printer

To select a printer, go to Printer Setting > Select Printer.

L

File(E) Option | Printer Setting | Ruler

Select Printer

Output Mode Settings
Use MultiLayer setting of the printer

The Select Printer dialog appears.

Select Printer

Printer Mame Drriver Name
MUTOH w1-628UF MUTOH w1-628UF
MUTOH w1-428UF MUTOH w1-428UF

Port

192.168.104.222
192.168.104.1258

Apply [

Close

Select a printer to print from and click Apply.
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7.27 Output Mode Setting

To select output destination of the data, go to Printer Setting > Output Mode Settings.

L~

File(F) Option | Printer Setting | Ruler

Select Printer

Output Mode Settings

Use MultiLayer setting of the printer

Output Mode Settings Ea

Cutput Destination

Apply Cancel

a | Printer

Output to the printer selected from the Select Printer menu.
b | LayerEditor

Output to the spool folder in Layer Editor. *1

Once the output destination is selected, it is displayed on the main menu as below.
Output Destination: Printer

Output Destination: LayerEditor

. Print Preview 3 Print Preview

?E' Print

‘ = Send to Layer Editor I

G) Version (D Version

*1 Layout Tool 2 Ver.1.6.0 does not support “LayerEditor” option for VJ-628.
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7.28 Keyboard Shortcut Keys

The keyboard shortcuts which can be used with Layout Tool 2 are as follows.

Edit menu
Keys Description Operable state
Cirla Select all objects in the printable | -Edit area
area. -Text edit window
i Insert an image displayed in i
Ctrl-i i ) i -Edit area
image preview to the Edit area.
Ctrl-z Undo an action.
See 7.32 Undo/Redo
Redo an action.
Ctrl-y .
(Redo the 'Undo' action)
Ctrl-c Copy object (image, text).
: - See 7.31 Copy and Paste Data.
Paste object (image, text).
Ctrl-v (The copied object retains the
same position in the Edit Area.)
File menu
Keys Description Operable state
Ctrl-n Create a new file
Ctrl-o Open afile In any state
Ctrl-s Save a file
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7.29 Cylindrical Printing using Rotary Unit

To perform layer printing on cylindrical items using Mutoh Rotary Unit, please also see
the Rotary Unit Operation Manual.

When a printer model which supports Rotary Unit is selected from the Select Printer
dialog, the following Rotary Unit option appears in the Choose Media dropdown list.

Rotary Unit

360.0x94.2mm

NOTE

® To perform layer printing using Rotary Unit, it is recommended to use Layer Editor to
perform single-layer printing. Multi-layer printing from Layer Editor is not
recommended since the next layer may not be printed on the intended position.

® Supported diameter of cylindrical item using Rotary Unit is from 30mm to 120mm.

® To perform 360 degree printing, choose an image which does not create the seam
visible or intentionally overlap the seam by a few mm to hide it.
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When the Rotary Unit option is selected from the dropdown list, the Rotary Media
Setting dialog appears to specify the size of cylindrical item.

Rotary Media Setting X
Media Size Image Size
Width
a 3600 |2 om 3500 mm
Circumference/Diameter
() Circumference =
30.0 = mm Circumference 942 mm
b (®) Diameter
Diameter 30 I 120
Narrow
C Wide
Restore Defaults
Apply Cancel

a | Width (for media)

5 mm margin is required at the left and right side.
Enter the media width in the range from 30mm to
360mm.

b | Circumference/ Diameter

Choose Diameter or Circumference by the radio
button.

When ‘Diameter’ is checked:

Enter the diameter of cylindrical item in the range
from 30mm to 120mm (94.2mm to 377mm in
circumference).

When ‘Circumference’ is checked:

Enter the circumference of cylindrical item in the
range from 94.2mm to 405mm (you can specify
more than the maximum diameter).

To overlap the seam line for 360 degree printing,
check ‘Diameter’ to enter the diameter of
cylindricdal item, then check ‘Circumference’ to
increase the value by clicking A button.

Roller Pitch setting on
the Rotary Unit

By entering diameter or circumference of a
cylindrical item, the diameter slider bar indicates
the appropriate roller pitch setting (Narrow or
Wide). Use this indication as a guide to decide the
roller pitch setting.

Make sure that the rolelr pitch setting on Rotary
Unit and opration panel are matched.
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The illustration below shows where the origin of image on Layout Tool 2 will be located
on Rotary Unit.

<Print start position >

%The following illustration shows while the image

<When printed on a cylindrical object>
is being printed.

@

When ‘180-degree rotation’ is disabled in the Origin setting (origin: top left):
1. Origin 2

A,
d

When ‘180-degree rotation’ is enabled in the Origin setting (origin: bottom right):
30 20 10 0

e
° S /

2 1. Origin
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When the Rotary Unit option is selected, the print mode and head gap settings are
automatically selected as follows:

Print Mode(resolution) Fast (720x1080 dpi)

Head Gap Large

® Users can change the print mode setting from the operation panel of the printer or
VSM remote panel. However, the printer always prints at 720 x 1080 dpi(Fast) for
any print mode.

Available print modes are as follows:
“Print Mode: Balanced”
Balanced mode of high quality print and quick print time.

“Print Mode: Fast”
Select this mode for high speed printing. Print quality might be reduced.

“Print Mode: Fine”
Select this mode for high quality printing. Printing speed would be reduced.
This mode can be effective for small diameter objects to improve print quality.

Layout Tools 2 also automatically selects the following high-density and ink adjustment
settings for white and varnish printing. If needed, change these settings to optimize for
an image and cylindrical item to be used.

White Printing High-density, Ink Adjustment 60%

Varnish Printing High-density, Ink Adjustment 60%

Varnish Printing
(Glossy Finish)

® In Rotary Unit option, the settings displayed in the Print Mode dialog vary from the one

used for normal layer printing.

When performing normal layer printing afte the cylindrical printing from the Rotary Unit
option or vice versa, go to the Print Mode dialog and click Restore Defaults or click
Open/Delete to open the print mode file that you want to use.

High-density, Ink Adjustment 100%

95



Layout and Print Tool 2 Operation Manual

7.30 Restore Window Layout

To restore the default window layout in Layout Tool 2, go to Option > Restore Window

Layout.

0 Untitled - Layout and Print Tool2

File(F) = Option Printer Setting  Ruler
Language Setting

Reset Window Layout

Media Profile Management
Change Background Color
Origin Setting

Printable Area Setting

7.31 Copy and Paste Object

An image or text added to the Edit Area can be copied and pasted using keyboard

shortcuts or mouse.

The copy and paste between Layout Tool 2 and other application is not available.

Once pasted, the copied object is placed on the top of the original one in the Edit Area

with a blinking bounding box.

This function is available by pressing Ctrl-C (copy) and Ctrl-V (paste; retain position), or
right-clicking on the object to access to the menu.

Function Operation
Copy by keyboard shortcut Ctrl-C
Paste by keyboard shortcut Ctrl-vV

Copy & paste by mouse

Right-click menu

Delete

Zoom to 100%
Bring to front
Send to back
Delete the guide
Original Image
Undo

Bedo

(Ctrl+Z)
(i)

Copy Object
Paste [Hold position]

(Ctrl+C)
(Ctrl+V)
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How to select image/text

Function

Operation

Select single image or text

Use the mouse to left click on the object.

o

@ @

Hold down the Ctrl key and left click on the
objects you want to select.

Select more than one objects

The red corner handles appear on each
corner of the selected objects.

[m| O O uj
doe opP
(o] o

doe oD

Select area

Hold down the Shift key and click-drag the
area you want to select using the mouse. A
gray bounding box appears while selecting.
The objects touched with the gray box will
be selected.

o O

(CNC)
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How to copy and paste

Left-click to select single object.

[=]

Q __O H
b G QP
7] ]
=
When using keyboard shortcuts with 10 0
Ctrl-C and Ctrl-V, the copied object is ‘ = '
placed on the top of the original one as B QAP
shown to right. You can see the blinking | X))
bounding box around the copied object. 3 0
=
Then, use the mouse to move the copied — 0
object to where you want. |
Q __O
10 | e GP & o H
8 doe ep
1 [
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This function is intended to use in the following cases:
When you want to lay out the same

image in the exact same position on the
different layers.

When you want to add the same image
to more than one sub area and add
different text to each image.

*If you just want to add the same image
to more than one sub area, use the
‘Duplicate image’ function.

7.32 Undo/Redo

Undo and Redo is available using the following keyboard shortcuts:
Undo (undo an action) Ctrl-z
Redo (reproduce an action) Ctrl-y

The actions are recorded by each layer in the Choose Layer dialog.
When it reaches the maximum log size, the oldest record will be deleted automatically.
The all record is cleared when a new file is created.

® Any insertion or removal records are stored in the same location. If memory shortage
occurs, an error message will be prompted.
In such cases, save the file and exit Layout Tool 2. Then restart the application.
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7.33 Test Print

7.33.1 Ink Density
Before you perform white or varnish printing, you can print the Ink Density chart to find
the optimum density for white or varnish ink.

To print, go to Option > Test Print > Ink Density.
o Untitled - Layout and Print Teol2
File(F) = Option  Printer Setting  Ruler
Language Setting 0
Reset Window Layout | I I I
Test Print > Ink Density |_

Media Profile Management

Change Background Celor
Qrigin Setting

Variable Data Printing
Printable Area Setting

In the following dialog, choose the Color Mode and Print Quality from the drop-down list.
If you want to print a chart for high-density or glossy finish, check the appropriate check
box. Once selected, click Print.

Test Print - Ink Density Chart e

The ink density chart (297x105mm) for white or varnish ink will be printed.
Check that the printer is ready to print, then click Print.

Test Print - Ink Density Chart

Color Mode White e
[JHigh-Density
Glossy Finish

Print Cuality Fine w
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Look at the print and find the optimum ink density.
Click the Print Mode Setting to open the following dialog, and enter the density chosen
from the chart.

55% 60% 65% 70% 75% s0% 85% 0%
20 density:0n) Print Quality:Super Fine

019/2/14 MUTOH XPI-461UF White(Hi

Print Mode X

Apply Layer 1 print mode setting

Profile LUH1
Print mode dialog value ‘
Layer 1 Setting
Reload when loadin; EvE
() Select print mode file ‘ Initial Setting / g
Jadrm ;
Open/Delete
(®) Specify print mode setting
Color Printing
Coler Balance Coler Balance
OFast Red: - | « [ 9] Saturation: - | « [
(® Fine
Green: I - EI Contrast: I + El
) Super Fine
Blue: I + E Brightness: I + El
[IMe Color Correction Gamma: 0.1 I 22
White Printing
Ink Adjustment DHigh'DEnsity Color Balance
() Fast
[ Choke Edges [ ] Spread Edges 0.10 "
®Fine g p g o Contrest: | < [
[ Enable gradation .
O Super Fine Brightness: | « [0
[ Ignore white in the non-alpha channel image om0 I =
Printing method Under coating OAllarea @ Image only
Varnish Printing
o Ink Adjustment %  [High-Density Color Balance
Fast
[JChokeEdges [ Spread Edges 0.10 : .
(® Fine O mm Contet I - El
Enable gradation
(O Super Fine Brightness: I - El
[ Ignore white in the non-alpha channel image [ Glossy Finish
Gamma: 0.1 I 22
Printing method Over coating OAllarea @ Image only
Head Gap @ Mormal Olarge Restore Defaults Cancel

® This feature is available on the XPJ-461UF/XPJ-661UF printer driver. For other
printer models, it will be supported sequentially through driver updates.
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7.34 Variable Data Printing

The variable data printing gives ability to print each copy by changing a text or image in
your design.

To perform variable data printing in Layout Tool 2, save a variable data file in CSV
format.

If you use the Duplicate Image feature, you can print more than one copy in a single
printing run by changing variable elements in each copy. See 7.23 Printable Area
Setting for more details about duplicate image.

CSV file

The following file format can be used for variable data printing.
File format Description
Csv Comma-separated values file
TXT Tab-delimited text file

Column and row limits

Column/ Row

Limitation

Column Up to 30 columns.
If the file contains more than 30 columns, the
exceeded data will be ignored.
Row No limitation.
pecial characters in the CSV file
Special characters Interpretation

] (half-width space)

Can be used as a character without enclosing in
double quotes.

“

(double quotation)

Can be used as a character.

¥  (yen mark/ backslash)

Can be used as a character.

The CSV file should not contain a string with line
breaks since an escape sequence cannot be
included.

, (comma) A comma is used to separate the columns of data in
each row.
To use it as a character, create a txt file with tab
delimited.

. (blank data) Can be treated as blank.
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To load images from a CSV file, a relative path or absolute path should be used to
specify the image file.

[d:¥LPT2¥test.csv] ...trigger a directory in the CSV file.
1l.png ...1) afile name only (current directory)
image¥2.png ...2) relative path (subdirectory)
image¥sub¥3.png ...3) relative path (subdirectory N level below)
.. ¥4 .png ...4) relative path (directory N level above)
. .¥aaa¥5.png ...5) relative path (subdirectory of the directory N level above)
d:¥sample¥6.png ...6) absolute path
Example)

ID, Name, Department, Photo

1001,Ichiro Mutoh,1st design department,image¥1001.png
1002,Jiro Mutoh,2nd design department,image¥1002.png
1003,Saburo Mutoh,3rd design department,image¥1003.png
1004,Shiro Mutoh,4th design department,image¥1004.png

® Ablank line with line breaks is ignored.

® The number of the columns present in the first row can be loaded to Layout Tool 2. If
other rows contain columns more than the first row, those data will be ignored.

® |f both text and image elements exist in the same column, the element attribute is
determined when the column is added in the Variable Data Printing dialog.
If an image path is present in the text element column, the string of the file path will
be inserted.
If a text is present in the image element column, it will be treated as “data not found”.
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How to load CSV file

1) Go to Option > Variable Data Printing.

o Untitled - Layout and Print Tocl2
File(F) = Option Printer Setting  Ruler

Language Setting

Reset Window Layout

Test Print

Media Profile Management

Change Background Color
Origin Setting

Variable Data Printing
Printable Area Setting

Variable Data Printing

a / [] Enable variable data printing
Add C5V File

b c
id.csw J Sync File\)

\djta Start Row = \ejracter Set | AMSI ~
o : 3 :

h/ 1002 | IROMUTOH | |2nd Design Se... | [image\1002.p... 9)

i Text Text Text Image
« 1) 2
\jj Mot added Added Mot added Mot added
+ + + +

-

Print Information
Mext Print Total Mumber of Rows

J/R':'W : \m/ 13 Rows
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Enable variable data

Check this box to enable variable data printing.

printing Uncheck this box to clear the Variable Data Printing dialog.
Load CSV Open the CSV file to load the variable data.
Sync file Load the CSV file again.

Data start row

(If the CSV file contains the header row) specify the row where
your data starts.

Character set

Choose the character set encoding used in the CSV file.

Row number Displays the row number in the CSV file.
i Click the left/right arrow to switch to the next/previous column
Left/Right arrows ) i
in the CSV file.
Contents Displays the contents written in the CSV file.
Attribute Displays an attribute of the variable element (text or image).
“Not added” appears if the column is not inserted (disabled).
Added/ Not added “Added” appears if the column is inserted (enabled) for variable
data printing.
) Click [+] to add (enable) an element to use it for variable data
Add object .
printing.
i Select the first row where the next print starts in the CSV file.
Next print

It will automatically count up once the print job is done.

Total number of rows

Displays the total number of rows loaded from the CSV file.

Check Enable variable data printing, then click “...” to choose and load a CSV file.

Choose the character set from the drop-down list.

If the CSV file contains the header row, specify the row in the Data Start Row field.
Specify the row in the Next Print field to select the row where the next print starts.

Click “+” to add an image or text to use it for variable data printing.
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How to edit a text element

You can change a text font or color like usual font options.
See 7.12 Insert Text for more details.

JIRO MUTOH

-+ A No.2

Variable data printing
A=A

A

b c

a | Text preview

Displays a text currently selected.
You cannot edit the text in the preview. To change the text, edit
the text in the CSV file and click Sync File to load it again.

Add text

Column number

Displays the column number of the text selected.

Text alignment

Align a text in the element frame.

Q|0 T

Font

Click to open the Font dialog.

The length of the text inserted may vary by row. You can use the text alignment feature
to align text on the element frame.

Text alignment Function
Left align Align the text to the left in the element frame.
A ICHIRO
Center Align the text in the center of the element frame.
A MU IRO
Right align Align the text to the right in the element frame.
A MUTOH
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How to edit an image element

The layout of the text can be changed within the element frame.
You can use the Image Frame Fitting feature to change the layout or resize the image.

® The cropping tool is disabled.

@

a_p

C QQ D

+ah| Nos
ORRO

° Variable data printing

-----------

Image preview

Display an image selected.

Add image

Column number

Displays the column number of the image selected.

o0 |TOlD

Image frame fitting

Scale or align an image in the element frame.
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Image Frame Fitting >
Scaling Reference Point
O 100% O O O
() Fit to frame height O ® O
() Fit to frame width
O O O
(®) Fit to frame
Ok Cancel
Scaling Function
100% An image can be printed with original size.
Fit to frame height An image is scaled to fit to the height of the element
frame.
Fit to frame width An image is scaled to fit to the width of the element
frame.
Fit to frame An image is scaled to fit to the height or width of the
element frame whichever greater.

To move the position of the image in the element frame, change the referent point.
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How to print

Once you finish editing, you can print from Layout Tool 2 by usual printing methods. See
7.17 Print, 7.18 UV Flatbed Printing, or 7.19 Roll Printing for more details.

After printing, the Next Print row will be updated automatically.

When printing one copy in a single printing

When using sub area + duplicate image

o

l
After printing
5

l
After printing
o 5

® |f you are using a roll printer, you can continuously print multiple copies by specifying
the number of copies in the Choose Print Mode dialog.
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7.35 Version Check

Click Version.

!E.- Print

(D Version

M Exit

The version of Layout Tool 2 will be displayed.

Wersion ﬂ

Layout and Print Tool2

@ Version 1.6.0

(C) Mutoh Industries Ltd, 2017

OK

8 License

This application uses following open source library.
For this software license agreement document,
please see LICENSE file in the application folder.

Open Source Computer Vision Library (OpenCV)

Ver.2.4.10

Copyright (C) 2000-2008, Intel Corporation, all rights reserved.
Copyright (C) 2009-2010, Willow Garage Inc., all rights reserved.
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